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o Step-by-Step Instructions —an easy-to-follow format relevant for novice and
experienced ArcGIS users.

o “Scoping It Out” boxes — boxes found in the margins that feature tools, tips and tricks
to enhance the student’s ArcGIS experience.

¢ Finished Layouts —a self-assessment tool to ensure successful lesson completion.

e Scenarios —a process in each lesson used by professionals in the science, technology,
engineering and mathematics industries letting users simulate an actual industry
application.

ArcGIS is a software suite developed by Environmental Services Research Institute, Inc.
(ESRI). 1t is designed to analyze and model geospatial data. This book will use three major
components of the ArcGIS software suite: ArcMap, ArcToolbox and ArcCatalog. ArcMap is the
primary part of the suite used in the book to display, create and analyze different types of
geospatial data. ArcToolbox contains various geoprocessing tools used in the ArcGIS suite to
complete tasks such as creating buffers, merging shapefiles and creating address locators.
ArcCatalog is the “virtual filing cabinet” where users create, manipulate or preview data and
metadata. ArcGIS is widely used among today’s GIS professionals and students. Students
using this software transition more smoothly with their GIS skills from the classroom to the
workplace or other academic pursuits.
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These lessons are intended for use in preparation for the TSA National Geospatial Contest.
The lessons provide a range of ArcGIS geospatial skills from geoprocessing to layout creation in
the context of Green & Sustainability careers. The subsequent lessons each focus on one of
three green and sustainable career directions using skills for the Science, Technology,
Engineering and Mathematics career cluster.

Each lesson introduces a slightly different set of geospatial skills. The skills sets used are
nonlinear in nature, meaning you do not have to complete Lesson 1 before you can cover begin
Lesson 2 and so on, but it is recommended to complete all lessons to gain experience using
ArcGIS.

Before beginning, ensure that you have downloaded and installed the required dataset from
www.digitalquest.com/tsa.html.

These lessons are part of a larger course, aGIS in STEM, from Digital Quest. For more
information or questions about working with these lessons contact or questions on the rest of
the course contact Digital Quest via phone at 1-877-5Remote, extension 1 (877-573-6683, ext.
1), email at supportusers@digitalquest.com, or visit: www.digitalquest.com.
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" a Geospatial Industry Series in STEM

Using GIS to Support
Sustainable/Green Technology

Lesson 1: Can We Preserve Green Space in our Community?
Using Geospatial Technology to Find Green Space

Economic growth is almost always beneficial to a community. New buildings, parking facilities,
streets, and sidewalks are all part of the growing process. Equally as important to a community
are areas that preserve the natural assets of a community. Before all of the new places to eat,
shop, and work are built, what can be done to preserve areas that community members and
visitors could use to go to relax? Many communities want to create master plans that include
both economic development and also protect the environment. Green spaces are not only an
aesthetically pleasing “get away” in an urban area, but may also serve as a place where wildlife
and certain species of plants can prosper. Added benefits such as improving the air quality as
well as the reduction of both noise and water pollution can also come from having a green
space in a community.

Where does a community planner begin in conserving green space? One plan of action could
be to utilize natural features in the area such as a grove of trees or a natural stream or pond.
The town of New Paltz, New York, already had a small public green space but they also had a
heavily forested area complete with streams, wetlands, woods, plants, and animals. The idea
was proposed to create a nature preserve, public park, and trail system to protect the area and
to give the community an additional, much larger green space with multiple access points.

A plan was set forth to create this green space based on one of the area’s most popular
residents, the beaver. Although numerous plants and other animals live in the area, why would
the focus be directed solely at the beaver? Several reasons actually:

= Beavers change the ecosystem to suit their needs,
= Beavers provide habitat for other species that wouldn’t be found there otherwise,
= Beavers provide greater biodiversity, and

= Beavers change their behavior as the system changes.’

The focus of the plan may be on the beaver, but the actual dimensions of the property are
determined by those who live in that area and who own the property. The property owners
around this proposed area were identified and then contacted. These owners were extremely
receptive to the idea of a preserve and indicated of their willingness to participate in committing
land to the preserve. The issue at this point was how to determine the core area within these
property lines that should be designated for this Nature preserve. For the town of New Paltz,
some considerations in concluding where the preserve should be are: giving the water and
wetland areas a 100-foot buffer, allowing for adequate beaver forage area, and steep slopes.

'Meltz, Don. (2010, February). Mill Brook Preserve, Concept Development. PowerPoint Presentation, Slide 9, New
Paltz, New York.
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Opening an ArcMap Document

You will now use an existing ArcMap document to add, and then analyze different layers of data
for the New Paltz Mill Brook Preserve. ArcMap is launched in the same manner as most
Windows-based application programs.

1. Start ArcMap by double-clicking the &S&El shortcut on your computer desktop (or by

L. I} All Programs
, pointing to and then

clicking the Windows Start button

{ ArcGls )y and selecting Q ArcMap 10 )
) ArcMap - Getting Started __.|I
2. When the ArcMap Getting Started window appears,
Double click Browse for more... and navigate to the Open existing map or make new m
C:\DQNAGIS\STEM\Lesson01 folder. E1- Existing Maps
. - Browse for mare...
3. Select the STEM_Lesson01.mxd file. El- New Maps
My Templates
. Open El- Templates
4. Click Q . [BI-Standard Page Sizes

Architectural Pag

150 (A) Page Siz

.- Morth American |
The map document you opened contains a map of Ulster

County, New York, and a file with places (cities, towns, and villages) in this county.
Before working on this document, it is important to save a copy to your student folder.

5. Select Save As... from the File menu to save this ArcMap map document in your
student folder.

6. Name the file STEM_Lesson01_XX (where XX is your initials).

Selecting Tabular Data

The town, or village, that this study focuses on is New Paltz, New York. To begin we will locate
New Paltz, and then zoom in to that area in ArcMap.

1. Right click on the UlsterCountyPlaces file and select Open Attribute Table.

2. Under the NAME column, scroll down until you see New Paltz.

3. Single click the [ attribute box to the left of this entry.

This will highlight the entire row in the table and it will
highlight this town on the map.

f =T =
| T Attributes of UlsterCountyPlaces =B #®

:
n | 20(36111  |G05E
21[3%111 |51
0| 22|31 |&
23| 36111

[ 243101 s |
IR

w|m|  Show: [ A Selected | fisconts (1 out of 36 Setectad) options = |
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4. Right click on UlsterCountyPlaces again, this
time go to Selection, Zoom to Selected Features.

5. On the Tools toolbar, select the Clear Selected
Features & button.

The area that is being considered for this green
space is located in the village of New Paltz. A
group of land owners is willing to commit portions of
their property to this project. The nature preserve
will be built in this area. You will need to add the
property owners file then zoom in even further to
study this property.

+

6. Click the Add Data
folder.

button and navigate to the C:\DQNAGIS\STEM\Lesson01

7. Double click PropertyOwnerBoundary.shp to add it to the map display.
8. Right click on the PropertyOwnerBoundary and select Zoom to Layer.
Because this will now be the area of focus, you can turn off the other layers.

9. Turn off the UlsterCountyPlaces and the UlsterCounty layers by unchecking them in
the table of contents.

Creating Buffers

When considering an area for a nature preserve, one major task is to make sure that the natural
resources of the area are protected. If there are any endangered species, streams, wetlands,
habitats, etc., efforts should be made to provide a protective barrier around these natural
assets. Wetlands, for example, are federally protected. Many states also have laws or
regulations to protect wetlands. For this study, you will first need to secure a 100 foot buffer
area around the wetland and water areas.

1. Click the Add Data ¥ button and navigate to the C:\DQNAGIS\STEM\Lesson01
folder.
2. Use the Ctrl key to select the Streams.shp, Water.shp, and Wetlands.shp files.

3. Click $ to add them to your map display.
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10.

11.

12.

&8 ArcToolbox

Open ArcToolbox by clicking on the ArcToolbox button on - 3D Analyst Tools

the Standard toolbar.

=& Analysis Tools
& Cartography Tools
& Conversion Tools

This will open the ArcToolbox pane in the ArcMap window. =@ Data Interoperability Tools

Double click Analysis Tools to expand its menu.

Double click Proximity to reveal its options.

- Buffer

@ Multiple Ring Buffer |

In this case, you will need a 100 foot buffer. Double
click Buffer to open the Buffer dialog box.

In the Input Features box, click the down arrow =l
and select Wetlands from the options listed.

~

For the Output Feature Class, click the Browse i
button and navigate to your student folder.

Enter Wetlands_100ft_Buffer and then click

Save

Enter 100 in the Linear unit box and verify the units
of measurement are in feet.

Leave all other fields to their defaults and click

to run the buffer.

=& Data Management Tools
=i Geocoding Tools

=& Geostatistical Analyst Tools
=& Linear Referencing Tools
&1-& Mobile Tools

=& Multidimension Tools
=& Network Analyst Tools
=& Samples

=& Schematics Toals

=& Server Tools

& Spatial Analyst Tools

&P Spatial Statistics Tools
=& Tracking Analyst Tools

£, Buffer L e
Inpust Features -
[Wetlands E =
Output Feature Class

C:\Shdent FolderiWetlands_1004_Bulfer <hp =l

Distance [value or field] ==

2} Linnar and — = —
hov  |Feet -

Field

Sude Type {optionad)
FULL -

End Type: (optional)

Dissolve Type (optional)
NOME -
Dissolve Fleld(s) (optional)

CalcAcres
Code
Knviat
StomeCode
WeadCode
Descrip

'

Scoping It Out...
ArcMap automatically organizes
layers as they are added in this
order: points, lines, and polygons.
The newest of each category will
be placed at the top of that
category when added. For this
reason, the Wetlands buffer you
just created was added on to the
top of the polygons listed.
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13.

14.

15.

16.

17.

18.

To be able to see the Wetlands layer, click on it in the table of contents and drag it

above the Wetlands 100ft Buffer layer.

=] Wetlands
ER

=] Wetlands_100ft_Buffer
[

The buffer that was just created represents an area adjacent to the wetland areas that

should be left in its natural state. This means that sidewalks or driving areas, for
instance, should not be developed in the buffer zones. Like the wetlands, the other
areas of water should also be given a 100 foot buffer.

& Buffer (=5 e
Create a 100 foot buffer around the Input Features A
Water file using the same procedures [Water ~ e
as above. Output Feature Class -
C:\Student Folder\Water_100ft_Buffer.shp B
Save the buﬂ:er as Distance [value or field]
. @ L ;
Water_100ft_Buffer in your student & Lnearunt
- - fioo IFeet v‘
folder. © Field i
OK l I Cancel ‘ I Environments... ‘ l Show Help == ‘

Drag the Water layer above the

Wetlands layer in the table of
contents.

Create a 100 foot buffer around the Streams file using the Buffer tool as you did

above.

Save the buffer as Streams_100ft_Buffer.
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Merging Shapefiles
For easier file management, you will create one shapefile to display all of the buffer zones
together. This will be done through a process called Merging.

A Merge | =En X
1. In ArcToolbox, double click Data S A
Management Tools to expand that toolset, | T B
then General, and then Merge. i
C:\Student\Woody\STEM\Lesson04\Streams_100ft_Buffer.shp +
. —. C:\Student\Woody\STEM\Lesson04\Water_100ft_Buffer.shp
2. Click the down arrow =l in the Input C\Student\Woody\STEM\Lesson0d\Wetiands_100ft_Buffer.shp

111

Datasets section and select
Streams_100ft_Buffer,
Water_100ft_buffer, and then
Wetlands_100ft_buffer.

SIEINEY

Output Dataset

3' In the OUtPUt Dataset bOX’ CIICk the C:\Student Folder\Streams_Water_Wetlands_100ft_Buffer.shp
Browse = button and navigate to your F‘i‘ﬁgﬁj&é“(ﬁ‘:;?” .
student folder. 3 BUFF_DIST (Double) |i|

fi} AREA (Double) —
4 s this dat t %—-Ca\mcres(Duub\e] |X 5
. ave this dataset as
Streams_Water_Wetlands_100ft_Buffer. [ o ]| comel |[emromens..| | stontep>> |
5. During the process, this trailer [er--Mulliple Rini will appear at the bottom of your screen.

It will disappear when the merge is complete.

6. Click to begin the Merge process.

7. Because you will no longer need the initial buffers (Streams_100ft_Buffer,
Water_100ft_Buffer, and Wetlands_100ft_Buffer) that you created, right click on
each them and select remove.

8. In the table of contents, drag the Streams_Water_Wetlands_100ft_Buffer layer below
the Water and Wetlands layers.

9. Single click on the symbol in the table of contents for the
Streams_Water_Wetlands_100ft_Buffer to open the Symbol Selector box.

i & P

10. Change the color to [M*9B| and then click
to close to apply the new color.
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Creating a Multiple Ring Buffer

Now that the water and wetland sources have buffers, you will need to focus on the needs of the
beaver. Beavers will typically settle along the banks of a water source such as a stream or
river. When beavers build a dam, they not only are building a structure in which they will live,
but they also change the surrounding ecosystem. This change usually happens when the
stream backs up or at least slows, allowing other living organisms to thrive and survive in that
area. In order to determine a good core preserve area, the beaver must be allowed area in
which to forage. These animals will usually forage 350 feet (with some venturing up to 650 feet)
from their dam. A multiple ring buffer will need to be created to represent these two ranges from
the streams in the preserve area.

1. Single click the symbol for Streams in the table of contents to open the Symbol
Selector box.

2. Edit the color to LEY®"_I and then click to apply the change and close the
Symbol Selector box.

3. In ArcToolbox (under Analysis Tools/Proximity, if ArcToolbox was closed), double click
on Multiple Ring Buffer to open the Multiple Ring Buffer box.

4, In the Input Features box, click the down arrow -l and select Streams from the
options listed.
' Multiple Ring Buffer PE
5. For the Output Feature Class, click mput Features -
the Browse © button and navigate to Lsfpeffst e = &
yOUI‘ student fOIder. C:\Student Folder\Beaver_Forage_350_650_Buffer.shp E
Distances
6. Save the file as -
Beaver_Forage_350_650_Buffer. - *| =
*x
7. For the first distance, enter 350 in the E|
Distances box. —
+
8. Click ﬂ Add button to send this I
number to the box below Distances. = {oprenel) -
Field Name (optional) =
9. Enter 650 |n the Distances bOX and [ oK ] | Cancel | | Environments... | | Show Help >=>

click ﬂ again to add this total in the
box below Distances also.

10. Edit the Buffer Unit to Feet.

11. Leave the other options as is and click to run the multiple ring buffer.

Copyright © 2013 Digital Quest, Inc.



12.  During the process, this trailer '¢r--Multiple Rintwil| appear at the bottom of your screen.
It will disappear when the multiple ring buffer is complete.

13. Drag the Beaver_Forage_350_650_Buffer below the
Streams_Water_Wetlands_100ft_Buffer.

14. Single click on each of the colors
for this layer in the table of
contents to edit them to shades
of brown as shown.

All of these buffer areas represent
areas that should be included in
the preserve and left as
undisturbed as possible.

Land Cover and Food Sources

Upon inspection of the property, it was discovered that there was a slight variance in land cover.
There were areas of woody vegetation, hemlock stands, areas with steep slopes, and several
others. Beavers, being herbivores, forage on items such as leaves, twigs, woody plants, and
aquatic vegetation. Aside from the steep slopes, the woody areas represent places that the
beavers may visit to forage but not necessarily use for their habitat. Steep slopes, on the other
hand, represent areas that are not necessarily suited for building human residences or beaver
habitats but represent areas that naturally add to the nature preserve. You will now map these
different types of areas.

1. Click the Add Data 4 button and navigate to the C:\DQNAGIS\STEM\Lesson01
folder.
2. Double click PotentialBeaverFoodSource.shp to add it to your map.

3. Repeat Steps 1 and 2 to add Hemlock_Stand.shp, and Steep_Slope_Area.shp

You will now Merge these layers together into a single layer that represents food
sources (in addition to their habitat) or natural features that are to be avoided during
development.
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4. In ArcToolbox, open the Data Management Toolbox by double clicking on it.

5. Double click on the General tray icon and £ Merge EE <
then the Merge tool to open the Merge box. ‘
Input Datasets -
=
6. For the Input Datasets, select —
Hemlock_Stand, Steep_Slope_Area, and P *
POtential_Beaver_FOOd_Source. <> PotentialBeaverFoodSource x
. B
7. Save the Output Dataset in your Student —
Folder as hd
Nonbeaver_Habitats_and_Steep_Slopes.
. . Output Dataset
8- When the Merge 1S Complete’ CIICk C:\Student Folder\Nonbeaver_Habitats and_Steep_Slopes.shp
Close Field Map (optional)
: F- CalcAcres (Double)
1) Core (Text) |i|
1 CoreExtend (Text) —
-%- Function (Text) | x| -
9' Edit the SymbOIOQy Of th|S Iayer tO Doy by 0K | ‘ Cancel | ‘ Environments... | ‘ Show Help >> ‘
single clicking on the symbol for

Nonbeaver_Habitats_and_Steep_Slopes
in the table of contents.

10. Right click and remove Hemlock_Stand, Steep_Slope_Area, and
Potential_Beaver_Food_Source layers.

In order to be able to better view the Property_Owners_Boundary, you will need to edit
and move it.

11.  Single click on the symbology for Preview
Property_Owners_Boundary to open the Symbol Selector
box.

Options
Fill Calar

12.  Select!H9% | and change the Outline Color to bright Red.

Outline Width

13. Edit the Outline Width to 2 and then click . Qutline Color.

14. Drag the Property_Owners_Boundary above
Nonbeaver_Habitats_and_Steep_Slopes layer in the table of contents.

NIE
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Clipping & Merging Layers

In order to get a better idea of the area that will be the “core” of the nature preserve, the layers
will have to be clipped to show only what is involved in the border of the Property Owner’s
Boundary.

1. In ArcToolbox, double click the Analysis . ip = |C e
toolbox to open it. — .
|Streams,Water,WetIands,lDth,Buffer > @
2. Double click on the Extract toolset and then Clp Features —
double click on the Clip tool. | PropertyOunerBoundary - 8
Output Feature Class
3. For the Input Features, Select Xi::::::z:lod;ir:::;ams_Water_Wet\ands_lDth_POC\ip.shp
Streams_Water_Wetlands_100ft_Buffer. Fet v
4. In Clip Features, select
Property_Owners_Boundary.
5. For the Output Features Class, navigate to
your student folder and save the file as
Streams_Water_Wetlands_100ft_POClip.
6. Leave XY Tolerance as |S and C"Ck | 0K H Cancel ||Enwranments... H Show Help >

7. Turn off both the Streams_Water_Wetlands_100ft_Buffer and the
Beaver_Forage_350_to_650_Buffer in the table of contents.

8. Merge the Streams_Water_Wetlands_100ft_POCIip and the
Nonbeaver_Habitats_and_Steep_Slope areas using the Merge tool.

9. Save the Output Dataset in your
student folder as
Core_Preserve_Area.

has been mapped out, planners will have a
visual aid to guide them in making the
decision of the perimeter of the Mill Brook
Preserve.

Now that the core area of the nature preserve | r\}\

Can you think of other applications in your
community in which these steps could be
taken to make a decision?
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A Geospatial Industry Series in STEM

Data Management Tools — Merge & Clip

Whenever data is acquired for a project, if it was not made specifically for your project, it may be
too expansive for your needs. Too much data may be confusing and may seem to slow the
performance of your computer. In this lesson you learned how to consolidate data by merging it
and how to eliminate excess parts of the data files away via clipping. Neither of these acts
permanently alters the original files. The original files can be added and analyzed in this or in
other ArcMap documents. Being able to properly manage data is a valuable skill that many
geospatial technicians must learn to be effective project managers.

Copyright © 2013 Digital Quest, Inc.
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a Geospatial Industry Series in STEM

Using GIS to Support
Sustainable/Green Technology

Lesson 2: Where Can A Biodiesel Fuel Company “Strike” Qil?

Using Geospatial Technology for Biodiesel Location

Biodiesel is a fuel alternative that is made from renewable resources such as those found in
vegetable oils or animal fats. The fuel is available as pure biodiesel or biodiesel blends that
contain certain percentages of biodiesel along with petroleum diesel. Biodiesel is nontoxic and
burns cleaner than petroleum fuel and is, therefore, more desirable for the environment.

Soybeans are one of several sources that can be used for biodiesel production. After they no
longer need the oil from their deep fryers, many restaurants have to dispose of their waste
vegetable oils (WVO). These oils can be taken and refined into biodiesel. Biodiesel fuel can
also be made from algae! Finding biodiesel can be a challenge. However, more retailers are
starting to carry it. Some websites list biodiesel retailers, including maps for those nearest you
or ones that can be found along a route of travel.

Scenario:

Tempe, Arizona, is located just west of Phoenix. It is a college town with many different
things to see and do. The college students as well as the locals have a vast array of
restaurants from which to choose when dining out. Knowing it has plentiful resources in this
area, a new company, BioDFuels, has moved into town. This company offers restaurants a
service for free for which, up until now, they have had to pay - collecting used cooking oils,
also known as waste vegetable oil (WVO). One hundred percent of the products that
BioDFuels gets from area restaurants will be recycled into biodiesel fuel that the company
produces. The processing of the oil can take place in one day so literally the oil your fries
were made in on Monday can be pumped into your car on Tuesday!

Along with producing a consumable product, restaurants are in the business of making
money. BioDFuels, a biodiesel manufacturer, is in the process of building a biodiesel
refinery in Tempe. This green company wants to contact local restaurants to see if it can set
up schedules for picking up WVO. Your task will be to create a map and two reports
showing the locations of these restaurants.

Opening and Saving an Existing Map Document

1. Start ArcMap by double-clicking the &&&El shortcut on your computer desktop (or by

. . L. ' » All Programs
clicking the Windows Start button BE&E—2S8  pointing to and then

ArcGIS ) and selecting @ arcMap10 )

Copyright © 2013Digital Quest, Inc.
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[=|-Existing Maps

I Recent

In the Opening box, select Browse for more =~ ~8rowseformore..  ynder Existing
Maps, navigate to C:\DQNAGIS\STEM\Lesson02 folder.

Double click on STEM_Lesson02.mxd to open
the map.

The map you are looking at is of Maricopa County,
Arizona. This county has several well populated
places, and our study area will work with a cluster
of them including Phoenix, Tempe, Chandler, Mesa,
and Gilbert.

This map will need to be saved to your student
folder so that you may edit it as necessary.

aSuw_As

I Savein | L SwasmFolder _L! & @ oF B
From the Main Menu, select File, Save As. B, Name E Date modified

nen:m:'lfl‘sces Mo items match your search.

|

| Diesktop

! Cetes
Navigate to your student folder and name A
the file STEM_Lesson02_XX (where XX is {@'..__'
your initials). Nonork

File name, |5TrM_| sssss 005 _30¢ mud _:J Save

To zoom in to the study area, right click on . i B e = e

Tempe_area_roads and select & Zoom To Layer

TSA Demonstration Lessons adapted from: a Geospatial Industry Series in STEM, 1% Edition



Adding and Editing Data Layers in ArcMap

The location of BioDFuels is in Tempe. You will now add it to your map.

1. Single click the Add Data | ¥ | button.

2. Navigate to the data folder C:\DQNAGIS\STEM\Lesson_05.

3. Double click BioDFuels_location to add it to your map.

4. Right click BioDFuels_location to display its menu options and select Properties.

5. Click the Symbololgy tab.

Symbal

6. Single click the Symbol box ' to open the Symbol Selector box.
Fraview

7. Single click Triangle 3 [T1angle 3 | to select it. B

8. Edit the color to bright yellow and change the size to 12. Options

Color:

9. Click L to close the Symbol Selector box and to Sze [200
apply the change to the symbol.

The symbol for BioDFuels will appear in
yellow on your map.

In order to establish a client base, BioDFuels would like to contact all restaurants near its
facility. As part of your job, you will need to create a list and a map displaying the locations of
these restaurants.

Creating an Address Locator

The names and addresses for all restaurants in Tempe have been given to you in the form of a
spreadsheet. Before you can geocode this list so that it may be seen on a map, you must
create an address locator. This address locator will enable the map to interpret the information
contained in the spreadsheet.

1. Click the Toolbox button on the Standard Toolbar. The ArcToolbox window will
appear on your screen.

Copyright © 2013Digital Quest, Inc.
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2. In the ArcToolbox window, expand the = @ Geocading Tools toolbox.

3. Double click the #* Create Address Locator too]. The Create Address Locator dialog box
will appear.
g ArcToolbox
& 3D Analyst Tools
& Analysis Tools
i@ Cartography Tools
& Conversion Tools
=& Data Interoperability Tools
& Data Management Tools g;
=& Geocoding Tools Ll .
}" Create Address Locator Scoping It Out...
. Geocode Addresses Geocoding is the process of
- Rebuild Address Locator taking street addresses
- Rematch Addresses (nonspatial data) and
-/ Standardize Addresses converting them to spatial
data so that they may be
viewed in a map.

. E,q' . Select Address Locator Style &J
4. Click the Browse button to the right of the
Select the address locator style to use:
Address Locator Style box. The Select Address General - Cty State Country
Locator Style dialog box will appear. General - Srgle mld
US Address - One Range

US Address - Single House
US Address - ZIF 5-Digit

5. Scroll to find the US Adresses - Dual Ranges s Address - 7 Range
address locator style and select it.

Description
6_ Click 0].4 ) US Dual Range Addresses

Note: This will cause an error indicator(s) to show:
@FeldMap  Thjs js only temporary and will be

remedied in the next few steps. == Lo JComa |
7. Click the down arrow ﬂ to the *\ Create Address Locator = |E] s

right of the Reference Data box Address Locator Style

and select the US Address - Dual Ranges

Tempe_Area_Roads data layer Reference Data ’

as the reference data. I - !
8. Verify in the Role cell to the right P S '

of the Tempe_Area_Roads data mesER "

layer in the Reference Data list 9™ ™\ a 2 amed®>0n,

that Primary Table option is selected.

9. Accept the defaults under the Field Map options.
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10.

11.

12.

13.

14.

15.

Scroll down (if necessary) and click the Browse g button to the right of the Output
Address Locator box. The Output Address Locator dialog box will appear.

Navigate to your student folder.

Name and save the address locator as Tempe_Area_Address_Locator in your student

folder.
Output Address Locator

| C:\Student Folder\Tempe_Area_Address_Locator =

Click L to create the address locator.

The Create Address Locator ribbon at the bottom of the screen will display the status
of the processing.

When processing is complete, clickg.

Close ArcToolbox by clicking on the ..

Geocoding Addresses to ArcMap
Now that you have created the address locator, the gecoding process can take place.

Click the Add data' ¥ button.

1.
2. Navigate to the C:\DQINAGIS\STEM\Lesson_05 folder and select the
Tempe_Restaurants.xlsx data file.
5. click__ "9 |
Workbooks typically come with more than one spreadsheet (i.e. Microsoft Excel gives
three spreadsheets for every workbook opened). Because of this, you will have to
designate the correct spreadsheet on the next screen.
4. Double click on Tempe_Restaurants$ to add this table to your map.
Because you have added a table, it will display [ # croose an adsres Locator to use.. P
as a layer on its own in the table of contents. Name escripton Add.
9.3.1 North America Geocode Service (ArcGIS Online)
9.3.1 US Streets Geocode Service (ArcGIS Onhne)
5. Right click on Tempe_Restaurants$ in your o ot s e oy
table of contents and select Geocode Fenpesren et 15 et g ks
8 Tempe_irea_Adress Locator __________Us oual Range Addresces |
Addresses.
Cancel
6. Select the Tempe_Area_Address_Locator
and then L.
Copyright © 2013Digital Quest, Inc. 17



. ( Geocode Addresses: Tempe area address locator | 2 dhI1
7. In the Geocode Addresses box, verify that
H Address table:
Tempe_Restaurants$ is selected as the S )
Address table. _
Address Input Fields
. . Street or Intersection: [ADDRESS ,]
8. Leave the Address Input Fields as is. .
City or Placename: [CITY .]
State: [ST,._\TE ,]
ZIP Code: [ZIP .]
Output
(@ Create static snapshot of table inside new feature dass |
9. save the Output in your student folder as Create dynamic feature dass related to table
Tempe Area Restaurants. Oulh:-ut shapefile DI.' feature dass:
- - C:MStudent_Folder\.Tempe_Area_Restaurants shp
. 0K .
10. Click 4 to run the geocoding _
[ Advanced Geometry Options. ..
process.
’ Geocoding Options. ..
&

w

When the process is complete, the completed box will appear:

Geocoding Addresses... &J
In this case, there are a total of 427 restaurants. All of ——— -
these 427 (100%) were able to be placed in their e 0 0%
approximate locations on the map. )

Not all geocoding processes produce results where all competed
addresses match and have a geospatial location on a map.
When this is the case, selecting Rematch will allow you to
either edit or further search the map for possible locations

for those addresses that are unmatched or tied.

1. click — %% |to dlose the Geocoding

Addresses box.

Average speed: 1,250,000 records/hour

(75

k]

I

s f

»

The new layer will be added to the table of contents and to
the map.

= Geocoding Result: Tempe_Area_Restaurants
-
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The layer will need to be renamed so that it will make sense to those reading the map.

12. Right click on the new layer Geocoding Result: Tempe_Area_Restaurants and open

its layer Properties.

13. In the Layer Properties box, select the General tab and edit the Layer Name to

Tempe Area Restaurants.

14.  Click L

15. Right click on Tempe Area Restaurants and Zoom to Layer.

Because BioDFuels will be providing a free service to these restaurants, if it has to travel too far
from its facility, the extra costs incurred to reach these restaurants may not be considered cost
worthy. |deally, within this first month of operation, BioDFuels would like to contact all
restaurants within 3 miles of its business. As a secondary approach, to be done within the
second month of operation, BioDFuels would like to contact all restaurants from just over 3

miles and up to 6 miles out.

BioDFuels now needs you to determine which of the local 427 restaurants fall into these

categories.

Creating a Multiple Ring Buffer

To determine which restaurants fall within 3 miles and 6 miles
of the BioDFuels facility, you will create a multiple ring buffer. A
buffer allows you to see how far something is from a specific
point in every direction. A multiple ring buffer allows you to see
more than one distance or time measurement from a given

point.

1. Click Open Toolbox button to open ArcToolbox.
2. Double click Analysis Tools to expand its list.
3. Double click Proximity to display its list.

4. Double click on Multiple Ring Buffer to open the Multiple

Ring Buffer box.

(23 ArcToolbox

% 3D Analyst Tools
E% Analysis Toals
@8 Extract

@& Overlay

=& Proximity

. Buffer

-3 Multiple Ring Buffer

Copyright © 2013Digital Quest, Inc.
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10.

11.

12.

13.

14.

15.

16.

In the Input Features box, select
BioDFuels_location.

Save the Output Feature class in
your student folder as
Buffer_3_6.

Single click in the Distance box
and enter 3.

Click the ﬂ to accept the 3.
Single click back in the Distance
box and enter 6.

Click the ﬂ to accept the 6.
Edit the Buffer Unit to Miles.

Leave all other fields as is.

Click x| to run the

buffer.

&7 Multiple Ring Buffer

[ )

:

Input Features

Output Feature class

Distances

|C:\DQI\AGIS\STEM\LessonUS\BioDFueIs_Iocation.shp [~ |

C:\Student Folder\Buffer_3_6&.shp

0 |

3

IENEINEY

Buffer Unit {optional)

Field Name (optional)
distance

Dissolve Option (optional)
ALL

Outside Polygons Only (optional)

Right click on Buffer_3_6 and select Zoom to

Layer.

Turn off both roads files by unchecking them in the

table of contents.

Close ArcToolbox by clicking on the !

Setting Selectable Layers
Counting the number of restaurants in each buffer would require a large amount of time. After
counting, you would still not have the names and addresses of these businesses. You will now
need to split the buffer so that you can determine which businesses fall where.

1.

oK l | Cancel | | Environments... | | Show Help ==
5 // : —
y ! :
g . “
' * .
T N b
/ oy §
/ (= T, Y
.-"/ /_./- o ke -
) y, .
/ f Y k\\

On the Tools toolbar, click the down arrow beside the Select Features by Rectangle

e - button.

Because you will be selecting the buffers, select|®_sectbyCice |

20
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3. In the map display window, single click inside of the first e leads g e
buffer (0 to 3 miles) to select it. The circle will have a highlight P e
around it. N

L]

4. In the table of contents, right click on Buffer_3_6 and s loe o
select Data, Export Data. S

5. Save the Output shapefile as 0_to_3_Miles_Buffer in your .
student folder.

6. Click ﬁ to add the exported data to the map.

7. Click the Clear Selected Features button on the Tools toolbar to clear the selected

buffer.

8. Click the Select Features by Circle @ button and click the outer buffer to select it.

9. Right click Buffer_3_6 in the table of contents and select Data, Export Data.

10.

11. Click ﬁ to add the exported data to the map.

12.
delete from the options shown.

Using Select by Location in ArcMap

Save this Output shapefile as 3_to_6_Miles_Buffer in your student folder.

Because you no longer need the original buffer layer, right click Buffer_3_6 and select

. elec ocation | ® ﬁ1
Now that you have two separate shapefiles to represent the two | = >
different distances from BioDFuels' location, you can create a e
list of restaurants for each. To do this, you will use Select by Selection method:
Locatlon . |se|ect features from -
Target layer(s):
. . . Tempe Area Restaurants
1. From the Main Menu, click Selection, then Select By D Sotfues ocaion
- Empe_area_magjor_roads
Locatlon [0 Tempe_area_roads
O 3_to_&_Miles_Buffer
[ 0_to_3_Miles_Buffer
[0 Maricop_County_Boundary
2. In the Select By Location box, verify that select
features from is selected in the first box.
Only show selectable layers in this list
H H Source layer:
3. Click the box beside Tempe_Area_Restaurants. 0103 Vi oo =
Use selected features (0 features selected)
Spatial selection method:
4. |n the s°urce Iayer: select o_to_3_Mi|es_Buffer Target layer(s) features are within the Source layer feature -
Apply a search distance
- - . eters -
5. In the Spatial selection method box, select Target R | S
layer(s) features are within the Source layer feature. relp [oc J[ oy | [ do=
i oK .
6. Click to run the selection.
Copyright © 2013Digital Quest, Inc. 21




Now that you have these restaurants highlighted, you need to export them as their own
shapefile to create your first list.

7.

10.

11.

‘e

Right click on Tempe_Area_Restaurants, select Data, e R

Export data.

Save the Output shapefile in your student folder as
0_to_3_Miles_Restaurants.

Click L to export the data.

Click ﬁ to add the exported data to the map.

Click the Clear Selected Features button on the
Tools toolbar to clear the selected restaurants.

You will follow the same procedures to designate those restaurants for BioDFuels second phase
of marketing — those over 3 miles by less than 6 miles away.

12.

13.

14.

15.

16.

17.

18.

19.

20.

From the Main Menu, click Selection, then Select By Location.

In the Select By Location box, verify that select features from is selected in the first
box and that Tempe_Area_Restaurants is still selected in the center box.

In the Source layer box, select 3_to_6
Miles_Buffer.

Verify that Target layer(s) features are within the .
Source layer feature is selected as the Spatial o
selection method. B

Click L to run the selection.

Right click on Tempe_Area_Restaurants and
select Data, Export Data.

Save the Output shapefile in your student folder as 3_to_6_Miles_Restaurants.

Click the Clear Selected Features button on the Tools toolbar to clear the selected
restaurants.

Because you already have restaurant data, you no longer need the
Tempe_Area_Restaurants layer. Right click on Tempe_Area_Restaurants and
remove this layer from the table of contents.

22
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Creating Reports in ArcMap

Now you have created two shapefiles that contain the information about which area restaurants
are within a 3 mile radius and which are more than 3 but fewer than 6 or fewer miles from the

BioDFuels facility. With this information, you can now create not only a map showing this, but a
report that will be able to be used for marketing purposes.

Report Wizard li?-J
1. From the Main Menu, click View, e m—
Reports, and then Create Reports to B — .
open the Report Wizard box. -
2. In the Layer/Table box, select Eg%fgdp T Aotress <
0_to_3_Miles_Restaurants. EEE%} [
e - [«
In the Available Fields window, all of the fields —— |
contained in the 0_to_3_Miles_Restaurants
table will be displayed. For this report, you will [ conca Motz ] [_Fmen
only need the name and addresses of the
restaurants.
3. Double click NAME and ADDRESS to send eondatics: ——
them both to the Report Fields window. ‘;“’”“ T
4, Click to view options for grouping
levels. Leave the grouping levels as they are
and click .
5. The third window of the Report Wizard allows o Bk N> i
you to determine how items are sorted. Click
6. The fourth window offers a chance to determine the layout and its page orientation.
Verify that Adjust the field width so all fields fit on a page is selected and then click
. Report Wizard l&J
\what title do you want for your report?
7. Now you may choose a style for your report. < R e
Select Stockholm, and then click .
8. Now you may give your report a title. Name it e you wantlo preview i reportor modify thereperts desian?
Restaurants Within 3 Miles of BioDFuels. o oo
9. After typing the title of your report, select the
radio button next to Preview the report.
[ Conodl ] [<Bak rr——
10. Select.
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You can now see a preview of

the report. In this preview, it
ZZ%WS that Ithe Name ?”d Restaurants Within 3 Miles of BioDFuels
ress columns are too
narrow and too far on the left
side of the report. These ENTERPRISES LN
fields need to be further T alEAcHE
edited. SPORTS BAR
TACO BELL 936 EAPACHE
BLVD
) Edit | HOP 225 EAPACHE
11. Click =" | to open BLVD
= KOREAM GARDEN 1324 SRURAL RD
the Report Designer .,

box that will allow you
to edit the individual properties of this report. This breaks the report up into its different
elements. Many of these elements are represented within text boxes that can be resized
and the text inside can be modified as well.

12. Single click in the box containing the report title to edit it.

13. On the Formatting toolbar, click the center align = button to center align the title on
the page.

14. Under pageHeader, select the NAME box. This text box that will need to be widened.

15.  Clicking on the right

[H ReportHeader

handle, resize the box to be :
approximately 3.5” wide. : Restaurants Within 3 Miles of BioDFuels

[H pageHeader

16. Select the ADDRESS box . : ADDRESS
and place it to the right of the = E:]:*a" —
NAME box. e
Page [PageMumber} of{PageCount
17. Resize the ADDRESS box to ==
approximately 3.5” wide.
18. Center align both of the Sreotee
column names. : Restaurants Within 3 Miles of BioDFuels
19. Under the detail section, @ gy
follow the same procedures =| & detai —
for NAME and ADDRESS. e NAME ADORESS
- = Page [PageMumber} of{PageCount;
=| H ReportFooter

20. Click on the Run Report button o at the top left of the Report Designer box.
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Restaurants Within 3 Miles of BioDFuels

A & W ENTERPRISES 1801 SJENTILLY LN
DUCKS RESTAURANT & SPORTS BAR 915 EAPACHE BLVD

1324 SRURAL RD
1314 SRURAL RD

MCDONALD'S
DENNY'S
WENDY'!

21. To save a copy of this report as a portable file, click the Export Report to file %8 putton
from the top menu in the Report Viewer window. This will allow you to view and be able
to print the report from outside of ArcMap.

Export Report =
22. In the Export Report box, under Filename Export Format ——— =)
save the document as Filesiame C\Studert_Folder\D_to_3_Mies_Restaurants_Fepr [ |
0_to_3_Restaurants_Report.pdf in your Convert metata png False
Export bookmarks True

student folder.

23. Click to export the report.

i3
Ll

24, In the Report Viewer window, click
format within ArcMap.

to also save a copy of the report in an editable

25. Navigate to your student folder and save this as 0_to_3_Restaurants_Report.rdf.

26.  Click %% to close the Report Viewer window.

You will follow these same procedures to
create a report for the restaurants 3 to 6
miles from the restaurant.

Report Wizard H-H

Which fioids o you want on your report?

LoyorToble: Blepont Vi Contents Frokd

#3_to_6_Mies_Restsurants - MAME -

27. Under View on the Main Menu, select Ao Fids
Reports, Create Report. | RooRess :
28.  Change the Layer/Table to >
3_to_6_Miles_Restaurants. T
29. Double click NAME & ADDRESS to make oy tes2 Finh

them move to the Report Fields window.

30. Click to view options for grouping levels. Leave the grouping levels as they

are and click .
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31.

32.

33.

34.

35.

36.

37.

38.

39.

40.

41.

42.

43.

44,

45.

46.

47.

Because you only have two fields, you will not need to sort the fields. Click

MNext » -

What tithe do you want for your repon?
o Hestourants Batwwon 3-6 Miles ol BioDF uuls)

Verify that the layout is set for Stepped and _
Portrait, and then click . ks i s e ok

Do e wesil B0 prervivw Thee ropon or modily the repod’s design?

Select Stockholm once again for the style Bhssnoiet
and then click .
Edit the Report Title to read Restaurants Conca <Back

between 3 - 6 Miles of BioDFuels.

After typing the title of your report, select Preview the report and cIick.

From the Report Viewer window, you will notice that the same changes will need to be
made to this report as was done in the previous report. You will also edit the color at top
of the report.

Edit...

Click - | to open the Report Designer window.

Under the Report Header section, single click the title box to select it.

On the Formatting toolbar, click the center align — button to center align the title on

the page. Note: if the title is cut off of the right side in the Report Designer window, manually click on it
and drag it to until it is centered.

Caor ===
abu =¥
On that same toolbar, select the Back Color “ button to open the : :
color palate window. - -
| |
u [

o
&

Select dark green M and then I‘ to close the color palate
box.

minl’

Under the pageHeader section, single click the Name box to select [omes ]
it.

Clicking on the right handle, resize the box to be approximately 3.5” wide.
Select the ADDRESS box and place it to the right of the NAME box.

Resize the ADDRESS box to approximately 3.5” wide.

Center align both of the column names.

Edit the back color of the Name and the Address boxes to dark green .

Under the detail section, resize the NAME and ADDRESS boxes.

26

TSA Demonstration Lessons adapted from: a Geospatial Industry Series in STEM, 1% Edition



48.

49.

50.

51.

52.

53.

54.

55.

56.

Center align both the NAME and ADDRESS boxes.

=] ReportHeader

Restaurants Between 3 - 6 Miles of BioDFuels

[=] pageHeader

ADDRESS

NAME
=| & detail

NAME
=| [E] pageFooter
=| [E ReportFooter

Click the Run Report

button at the top left of
the Report Designer box.

Page {PageMumber; of{PageCourt}

ADDRESS

NAME
VEGGIE FUN
S ITALIAN RESTAURANT
PICNIC CO GOURMET CAFE
JIM'S CONEY ISLAND CAFE
PHILLY'S SPORTS BAR & GRILL
BLUE IGUANA MEXICAN RESTAURANT
GRUMPY JOHN'S BBQ
JOAN'S KITCHEN
UDUPI CAFE
LA FONDA MEXICAN FOODS
LAYALENA
BURGER KING
SUBWAY SANDWICHES & SALADS
JACKIN THE BOX
DENNY'S
PAPA JOHN'S PIZZA
CATERED BY CROSSON
LUNCH BREAK
PERSOMAL GOURMET

Restaurants Between 3 - 6 Miles of BioDFuels

2240 N SCOTTSDALE RD 8
2210 N SCOTTSDALE RD
1144 WWASHINGTOM ST
1750 N SCOTTSDALE RD
1826 N SCOTTSDALE RD
1849 N SCOTTSDALE RD
1811 N SCOTTSDALE RD
1857 N SCOTTSDALE RD
1639 N SCOTTSDALE RD
1126 N SCOTTSDALE RD

1290 N SCOTTSDALERD £107

1210 N SCOTTSDALE RD
1380 N SCOTTSDALE RD
901 ECURRY RD
650 N SCOTTSDALERD
735 E UNIVERSITY DR
525 S MCCLINTOCK DR
455 S48TH ST=112
515 S48TH ST#108

-

To save a copy of this report as a portable file, click the Export Report to file % putton
from the top menu in the Report Viewer window.

In the Export Report box, under Filename save the document as
3_to_6_Restaurants_Report.pdf in your student folder.

Click to export the report.
™

In the Report Viewer window, click to also save a copy of the report in an editable

format within ArcMap.

Navigate to your student folder and save this as 3_to_6_Restaurants_Report.rdf.
Click .ij to close the Report Viewer window.

Save the project.
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Creating and Using Reports

To be the most effective, a report like this should also include contact information.
Additional fields might include phone numbers or email addresses. Because of the
length of these reports (one was three pages and the second was eight pages), it is not
useful to embed these reports in the map layout. They have been saved so that they
can be printed and given to a company such as BioDFuels to develop its marketing
plan. Can you think of any additional information that BioDFuels could benefit from
having in its reports? Can you see how this would be beneficial from a marketing
standpoint to a company?

Creating a Layout
The reports will supply BioDFuels with the list they desire however one additional task is to
create a visual representation of that data in the form of a map layout.

1. Switch to Layout View by clicking on the Layout

View |a button at the bottom of the map display
window.

2. Right click on 3_to_6_Mile_Buffer layer in the table e o=

of contents and select Zoom to Layer. o : \
e R L
3. Turn on Tempe_area_roads in the table of contents ‘ /,'.'_-::".'.;'.".’ “'\'; -
by checking it. FERE !

4. Single click the symbol below Tempe_area_roads to ; l\. 1 Wit |
open the Symbol Selector box. \ =

5. Edit the color of the roads to Gray 20% and click

to close the Symbol Selector box. This =

will allow the points for the restaurants to be easier to
view.

6. From the Insert Menu, select Title.

7. Double Click the title to open the Title Properties Box. Edit the title to read
Restaurants Near BioDFuels.

8. Click .

9. From the main menu, click Insert >North Arrow and select a North Arrow. Drag it to
an area on the map in which it will not obstruct the view of any restaurants.
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10. Click Insert> Text. Type your name

and the date. Drag it to an area at Legend Wizard B
the bottom of the map.
Choose which layers you wantto include in your legend
Map Layers: Legend ltems
1. Insert a Scale bar and position it at rrr—rlll | ooy 5
the bottom of the map. e e 2 [
- Tempe_area_roads TtoTb_Mile Bufter 1
. . e 0_to_3_Miles_Buffer _arlzo_ o_un ounda
12. Right click on the Scale bar and 3.0 il Bufe Hencop-Lounty_Soundary 4]
select Properties. " Maricap_County_Boundary =
=] 2|

13. Change the Units to Miles and then

I:II{ Setthe number of columns in your legend: 1 El:
click :l

Preview
14. Insert a Legend to display all active
layers in the map. Next> Cancel

15. Click \L‘ to continue.

Legend Wizard

16. In the second window of the Legend Wizard, Fexand Tl
delete the word “Legend”.

17. Click\L‘ to continue. BRI S

18. In the third window of the Legend Wizard, change the background to Grey 10%.

19. Click\L‘ to continue three more times.

20. Drag the legend where it does not block any of the restaurants.

21. To save a copy of the map in a portable format, go to File, then Export Map.

22. Navigate to your student folder and save as STEM_Lesson_05_XX.bmp (where XX is
your initials).

23. Click = to save the document.
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Your map should look like this:

Restaurants Near BioDFuels

. . n
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oW . o, = é.,_‘,. !
: 3 ] i \'| i
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3 %
e b S BT i
+
.
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4l
+ 3 l0_6_Mlks_ResEumms /a"

+ 0o 3 Mies Resumns - 0000~
&« BhDFuels_location

Temps_zre3_rozds N
[ ]3_to_s_mnes_suser A
[ Jo.to_3 mmes Bumer
b _B 1 0 as 1 2 Mlkes D s
[] mancop_county_sounaary 5 z T

All three documents, the map and the two reports are now ready to be presented to

BioDFuels.
A Geospatial Industry Series in STEM

Creating and Using Reports

From geocoding to editing to creating reports, in completing this lesson, you have
learned many important skills that professionals in the geospatial industry use.
Although this lesson is centered on a company attempting to find clients by using these
skills, many other scenarios could be implemented here as well. A company could use
skills to map the locations of similar businesses (aka: its competitors) in the city or to
locate possible complimentary businesses (like to map locations of gasoline stations
that might be able to become biodiesel retailers). The next step up from this lesson
would be to use a networking extension to determine the best route to and from these
businesses.
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a Geospatial Industry Series in STEM

Using GIS to Support
Sustainable/Green Technology

Lesson 3: How can Geospatial Technology be Beneficial to

Conservation Biology?
Using Geospatial Technology in Habitat Preservation

Signs of progress are all around us. New homes. New roads. New buildings.
Although these changes are usually good for us, these signs of progress may not
be so accommodating to the animals that live in the areas being developed. As we
expand the boundaries in which we live and work, most of the animals and plants
that have inhabited the areas that we are taking over must relocate in order to
survive.

A number of species are in an endangered (meaning that the
species is like to become extinct) or threatened (meaning the
species may become endangered if no corrective measures are
taken) status. While not all of the problems in the animal and plant
kingdom have humans to blame for their current status, our actions __
can directly affect the futures of plants and animals. One way to
do this is to be environmentally responsible and investigate laws
and regulations pertaining to any endangered or threatened
species seen in or near your area.

Those involved in Conservation Biology want to perform actions that will keep
plants and animals from becoming extinct. Without their efforts, many of the plants
and animals that you see today would not be in existence. The following scenario
will take you on a journey that might actually take place in the life of a developer
with a keen sense for conservation biology.

Scenario:

XYZ Developers have been contracted to build a lodge in northeastern Chatham County, North
Carolina. While surveying the land for the best potential site within the property boundary, a bald
eagle is spotted. The bald eagle is considered “threatened” in the state of North Carolina. A
“threatened” status means that the species is likely to become endangered. XYZ Developers
knows that research must be done to ensure that the eagles and their habitats are not disturbed.
The situation raises questions such as: Can we still build here? How far away from the eagle’s
habitat must we build? These questions must be answered before work can proceed. At the time
of the surveying, a small section of Harperella plants was also found. This species of plant life is
considered “endangered” at both the state and national level. Endangered plants and animals are
considered to be extremely rare and in danger of dying out.

In this lesson, you, as an employee of XYZ Developers, will need to create a map displaying the
known sightings of bald eagles and of the Harperella plants in the area. Further analysis will need
to be done once this information is documented.
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Launching ArcMap:
ArcMap is launched in the same manner as most Windows-based application programs.

1. Start ArcMap by double-clicking the shortcut on your computer desktop (or by

. . . o I »  AllPrograms
clicking the Windows Start button , pointing to and then

| AICGIS ) ang selecting @ ArcMap 10 )

2. When the ArcMap window appears, @ rventap - Getting state
click the box next to New Maps, and T e T e e
then click Blank Map. Moo L
M-,al':r\:laln

Tempiates

Standard Fage Saes
B [:I I{ sachitectursl Fage Biaak Map
3 CIle IS0 {A) Poge Sze:

Horth Amarican (&
Tradtionsl Layouts

el Architectural Page Sizes A~
UsA ;
AT A
.I;afanh geodntabase for this mnp:” . . Mitiat is thes?
A completely blank map document will open. e SR
@ Untitied - ArcMap - ArcView = | B
.Ii.le Edlt View Iloukmarl.c'. Insert Se:.eé:lon I" B i C i Mindo .I.ieip
D8 E& - b L EEE@0
aaMmeiny L] [ =R % Drawing- & (mE S
| Table OF Contents 2%
1058y
Layers
= 10&2.3].5. 392.857 Unknown Units
4. Select Save As... from the File menu to save this ArcMap map [@=* _~
document in your student folder. -

5. Navigate to a location specified for you to save your work on
your computer hard drive. Name the new file
STEM_Lesson03_XX.mxd (where XX is your initials) and click

Save
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6. Click the Add Data button 4 on the Standard toolbar. The Add Data dialog box will
appear.

7. Navigate to the C:\DQINAGIS\STEM\Lesson03 folder.

8. Select the Chatham_County, Chatham_Roads, Chatham_Water, and
Woodlands_Lodge_Property files.

Although ArcMap may have assigned different colors to your map, it should look like this;
follow step 9 to organize your map like the one below:

9. Place the added layers in the order below in the Table of Contents. Edit the layers as
indicated below:

(NOTE: You may have to click the List by Drawing Order button :I in the above the Table of
Contents window if you are unable to reorder the layers.)

Feature
Chatham Roads Red, 1 point
Woodlands Lodge Property Beige
Chatham Water Lake
Chatham County Light Green
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Using the Zoom In Tool
The location of the Woodlands Lodge is located in the northeastern portion of the county. You
will need to zoom in to this area to study it more closely.

1. On the Tools toolbar, select the Zoom In tool _
: N o (BT S E)
. AV
2. Use the Zoom In tool to click, drag, and s

zoom to the approximate area indicated in the
image to the right.

As you can see from the map, the lodge will
be built close to this lake.

Creating a Shapefile in ArcGIS

Upon inspecting the land for surveying, at least three sightings of one or more bald eagles near
the property were recorded. The coordinates for the sightings were documented using a GPS
unit and are noted below. This information will need to be set up in a spreadsheet so that you
can add it as point data in ArcMap.

1. Open a new spreadsheet document in your computer’s spreadsheet program (IE.
Microsoft Excel).

2. Enter Sighting, Latitude, and Longitude on the top row of the spreadsheet.
3. Enter the data as shown below:
| A B C

1 Sighting Latitude Longitude

2 1st 35.764 -79.018

3 2nd 35.764 -79.036

4 3rd 35.729 -79.036

I.'|
4. Save the file a as Eagle_Sightings in your student folder as a Text (Tab

delimited)(*.txt). This txt file is the one you will add to your ArcMap document.

File name: Eagle_Sightings.bat

Save as type: |Text (Tab delimited) (*.txt)
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S
5, Click w

You will receive the following message:
Microsoft Office Excel | 2% |

The selected file type does not support workbooks that contain multiple sheets.
! . = To save only the active sheet, click OK.
» To save all sheets, save them individually using a different file name for each, or choose a file type that supports multiple sheets.

| OK | | Cancel |

6. Click ‘i/ because there is no data on any other sheet than the first spreadsheet
in the workbook.

The next message you will get will be the following:
Microsoft Office Excel | 23 |

Eagle_Sightings.bd may contain features that are not compatible with Text (Tab delimited). Do you want to keep the workbook in this format?

o = To keep this format, which leaves out any incompatible features, click Yes.
“ = To preserve the features, click No. Then save a copy in the latest Excel format.
» To see what might be lost, click Help.

| Yes | | Mo | | Help |
7. Select ‘i/ to accept the text format.
8. Close the spreadsheet (click No if you are asked to save the changes).

Adding X, Y Data to ArcMap
You will now add the table you just created to ArcMap.

+
1. Click the Add Data' | button on the Standard toolbar.

2. Navigate to your student folder and select Eagle_Sightings.txt.
This information is not yet ready to be displayed in ArcMap.
You will notice when you add it, your table of contents shifts

to the List By Source View This will enable you to work
with data that is not yet dlsplayed in a spatial format.

4 {11

Display Source

[ 8 =

3. Right click on Eagle_Sightings and select =¥ Display XY Data..
The Display XY Data dialog box will appear.

4, Confirm that Longitude and Latitude appear in the X Field and Y Field boxes
respectively.
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10.

11.

At this time, the spreadsheet that you added has XY coordinates. However, it will display
a coordinate system identical to the data frame; you must specify the geographic
coordinate system (Long, Lat) that the sightings are based on. There are several
different ways to give it a coordinate system. The method you will use for this lesson will
be to manually edit the coordinate system in the Display XY Data box.

Edit...
Click # to open the Spatial

Reference Properties dialog box.

Select.. |

Select to open the
Browse for Coordinate System folder.

Double click
F:IGeographic Coordinate Systems {5 gelect it.

Double click ANorth America to browse
for coordinate systems.

Double click @ NAD 1983 (CSRS).01j | Thig
will allow the data contained in the table to
know where to show on the Earth.

Appl
bl | to accept the

OK

Click

changes and | twice to
close the Properties and Display XY
Data windows.

Click if the message about
the Object ID Field appears. You will follow
these steps to create an object ID so that
you will be able to select, query, or edit the
features in this layer.

Display XY Data

(2] 5 |

Atable containing X and Y coordinate data can be added to the map as

alayer

Choose atable from the map or browse for ancther table:

| Eagle_Sightings.txt

Specify the fields for the X and ¥ coordinates:

X Field: |Longitude

=]
| Latitude ﬂ

Y Field:

Coordinate System of Input Coordinates

Description:

Geographic Coordinate System: -
MName: GCS_MNorth_American_1983_C3SRS3

F }

Edit..

[+ Warn me ifthe resulting layer will have restricted functionality

[ Show Details

OK ‘ Cancel

o] =]

Table Does Not Have Object-ID Field | 2

The table you specified does not have an Object-ID field so you will not
be able to select, query, or edit the features in the resulting layer, or define
relates for them.

After you create this layer, you can export it to a shapefile or feature class
if you need these functions. To export a layer, right-click it in the Table Of
Contents and choose Data>Export Data. Add the exported data to the
map as a new layer.

OK Cancel

36
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The points will show in the map display.
However, without the object ID, you will not be
able to conduct any analyses on these points.

If you look in the table of contents, you will
notice that the filename associated with the
eagle sightings ends in “Events”. This is
another reminder that this is a temporary file
and in order for it to be a true shapefile, you
will need to export it and save it.

12. Right click on Eagle_Sightings.txt
Events in the table of contents.

13. Select Data, Export Data from the options given.

14.  In the Export Data dialog box, select ® the data frame g that the layer’s coordinate
system will match that of the Data Frame.

15. Save the Output shapefile as Eagle_Sightings in your student folder.

OK
16. Click | to accept the changes.

Y
17. Click g to add the exported data to the map as a layer.

18.  Because you will no longer need it, right click = s
and remove the Eagle_Sightings.txt Events o B Fhathar D] BB
file. —

PN Mnne Arbeibadn Takia

Although the bald eagle is now off the federal endangered species list, in North Carolina the bird
is considered to be “threatened,” meaning it is likely to become endangered at some time in the
near future if current conditions persist. In addition to their state and federal status, bald eagles
are protected under the Bald and Golden Eagle Protection Act'. This act was initiated in the
1940s and has undergone several amendments since, but it “prohibits anyone, without a permit
issued by the Secretary of the Interior, from "taking" bald eagles, including their "parts, nests, or
eggs.” This act expands on “taking” to mean, among other things, to disturb or agitate a bald or
golden eagle to the point that it affects its “breeding, feeding, or sheltering behavior”. Violations
of this act carry a stiff fine of $100,000, imprisonment for one year, or both. All this can be the
case for a first time offender!

With this in mind, XYZ Developers wants to make certain that it is not in danger of violating any
rules with the bald eagles spotted near the building site of the lodge. Local wildlife officials were
contacted to find if there were habitats, or nests, in the area near the lodge site. A few days
later, it was reported back to XYZ Developers that only one habitat was found in the area. The
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reported sightings most likely were from eagles using that one habitat. The location of that
habitat was given to XYZ Developers in the format of an XY coordinate. You will follow the
same procedures as for the sightings to create a shapefile for the eagle’s nest.

1. Create a spreadsheet with the A B C
following information: 1 MNest Latitude Longitude

2 |Location 35.774  -79.014
2

2. Save the file as a txt file named Eagles_Nest.

3. Close the spreadsheet.

. +

4, In ArcMap, click the Add Data button on the Standard toolbar.

5. Navigate to your student folder and select Eagles_Nest.txt.

6. Right click on Eagles_Nest and select =¥ Display XY Data ..

7. Confirm that Longitude and Latitude appear in the X Field and Y Field boxes
respectively.

Display XY Data | @ 28 |

. Edit... . Atable containing X and Y coordinate data can be added to the map as
8. Click 4 to open the Spatial alayer
Reference Properties dialog box.

Choose atable from the map or browse for another table:

Select | | Eagles_Nest.txt J
9. SeIeCt . Specify the fields for the X and ¥ coordinates:
" " K Field: Longitud -

10. Double click r—-lGeographlc Coordinate Systems [Longiude =~

to select it YField  uatude ~

. Coordinate System of Input Coordinates

11.  Double click 2 North America to browse for Description

Coordlnate SyStemS' Geographic Coordinate System:

MName: GCS_MNorth_American_1983_CSRS

12.  Double click NAD 1983 (CSRS)pi  Thig wil
allow the data contained in the table to
know where to show on the Earth.

. Apply |
13.  Click to accept the :
oK | [~ Show Details Edit .
changes and twice to close
the Properties window. [v Warn me ifthe resulting layer will have restricted functionality

0K ‘ Cancel ‘

Once the file is added as an events layer, it will

need to be exported so that further analysis
can be conducted on it and to make the Shapefile permanent.
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14.

15.

16.

17.

18.

19.

Right click on Eagles_Nest.txt Events and select Data, Export Data.

In the Export Data dialog box, select ® the data frame g4 that the layer’s coordinate
system will match that of the Data Frame.

Save the Output shapefile as Eagles_Nest in
your student folder.

OK
Click | to accept the changes.

Y
Click g to add the exported data to

the map as a layer.

Right click and remove the Eagles_Nest.txt
Events file.

Editing Symbology in ArcMap
Now there will be four points showing on your map. Editing the symbology of these will make
your map easier to understand.

1.

Double click on the current symbol for Eagle_Sightings to open up the Symbol
Selector box.

The default symbols will be shown in the Symbol Selector window. Although there are
many to select from, other symbols from different categories are available.

Click Style References... to view the other categories of symbols to select from.

From the list of options, check Forestry.
crick L]
(1]

Scroll through the list until you find a pair of binoculars labeled Viewing Area 1

Single click on Viewing Area 1 to select it.

Edit the size to 15 and then click ‘L/ to close the Symbol Selector box.

Double click on the symbol for Eagle’s Nest.
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V)

Raptors

9. Scroll through the list to find Raptors

10. Single click to accept Raptors as the symbol.

11. Edit the size to 15 and then click ‘L/ to close the Symbol Selector box.

Creating Buffers Using ArcToolbox

The United States Fish and Wildlife Service has created a National Bald Eagle Management
Guideline in accordance with the Bald and Golden Eagle Protection Act and the Migratory Bird
Treaty Act. This guide is to serve as a guide to anyone who shares public or private lands with
these birds. In reading through this document, XYZ Developers has discovered that because its
lodge will be four stories high, any building must be more than 660 feet from the nest site. How
far is the eagle’s nest from their construction site? You will create a 660-foot buffer around the
eagle’s nest using the buffer tool in ArcToolbox.

1. On the Standard toolbar, click the ArcToolbox button é:
to open ArcToolbox.

The ArcToolbox Window will open in your ArcMap window.

2. Double click Analysis Tools to view its contents. (68 ArcToolbox
=& 3D Analyst Tools
3. Double click Proximity and then double click Buffer to =@ Analysis Tools
open the Buffer dialog box. @& Extract
% Overlay
4. Click the ™ on the right side of the Input Features box to =& Proximity
display the list of shapefiles in the Table of Contents -~/ Buffer
available for buffering.
5. Select Eagles_Nest as the Input Feature.
e
6. For the Output Feature Class, click the and navigate to your student folder.

7. Save the Output Features Class as 660ft_Eagle Nest_Buffer.
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2" Bufier =] < )
8. Type 660 as the Linear it Features &
. . . |Eag|es_Nest ¥y =&
unit. Verify that Feet is P ———
Set in the pu”dOWn menu. |C:\Student Folder\660_Nest_Buffer.shp ﬂ
Distance [value or field]
9. Leave all other fields as e — = =
they are. € Field
| =l
Side Type (optional)
. 0K FULL
10 CIle tO Stal”t Lnd Type (optional) J
the buffer process. During | Rouno _ =
the process, a scrolling f‘j,j:';’e Tipe (optonal, <]
marquee will appear at the Dissolve Field(s) (optional)
bottom of the screen. Cro
[ nest
[ Latitude -
oK Cancel Environments... Show Help >>
11. Once the process is complete, the ribbon at the bottom of the screen will disappear.

12. Close ArcToolbox by clicking on the %l in the top right corner of the ArcToolbox

pane.

13. Use the Zoom In C: tool on the

tools toolbar to zoom in to the area
including the two closest sightings
to the lodge area, the lodge area,
and the nesting site to better view
the buffer.

It appears from the buffer that the
lodge site is well beyond the 660
feet required by the Bald and
Golden Eagle Protection Act. This
is one major item checked off XYZ
Developer’s list.

Copyright © 2013 Digital Quest, Inc.

41



The new lodge is going to have two beach areas, a boat launching area,
and several walking trails. Proposals sites for these items have been
offered, but as of right now, no specific directions have been given to XYZ
Developers. Something that might help with its decision was discovered
when the eagle’s nest was found. The wildlife experts, who found the
eagle’s nest, also discovered that the property contains a very rare and
endangered plant, the Harperella. In the state of North Carolina, as well
as the rest of the United States, the Harperella plant is considered
endangered. Although no federal or state guidelines exist that specify a
distance that must be kept from these plants, experts know these plants
must not be disturbed. As a result of this information, XYZ Developers
wants to establish a barrier around the area immediately around these
4 plants as an environmentally conscious move. It will also supply the lodge
P e owners with this information so that they may post signs on the property
The Harperella is an before gueStS arrive.
endangered species

that thrivei"” m,lo"St and  The location of the group of Harperella plants found on the property has
Sou:::.' {,;O,I:,'-sh 8 been documented and a shapefile has been created. You will need to add

Wildlife Service this shapefile to your current map.

Options

Fill Color:
1. ¥ J

Click the Add data button | on the Tools toolbar.

Outline Width: ’@
2. Navigate to the C:\DQINAGIS\STEM\Lesson03 folder. :

Qutline Color: -
3. Double click to select and add the Harperella_Location file.
4. Double click the symbol for the Harperella_Location file to open

the Symbol Selector box.

5. Edit the fill color to White and the Outline color to Black with a
width of 1 point.

6. Use the Zoom In & tool to zoom in to the territory where the
Harperella is (South and East of the easternmost sighting).

Creating a Buffer Around a Polygon

These plants usually grow in rocky creek beds, on river banks, or in or near streams. They are
extremely fragile and should be shielded from any development or human contact. For these
reasons, XYZ Developers would like to create a 20 foot land buffer around these plants. It
would also like to designate a 200 foot “no wake zone” in the water around these plants.

1. On the Standard toolbar, click the ArcTooIbox button to open ArcToolbox.

&3 ArcToolbox

- 3D Analyst Tools
E% Analysis Tools
w8 Extract

2. Double click Analysis Tools to view its contents.

3. Double click Proximity and then double click Buffer to open
the Buffer dialog box.

=-& Proximity
L -/ Buffer
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4. Click the = on the right side of the Input Features box to display the list in the table of

contents.
5. Select Harperella_Location as the Input #* Buffer |-ﬂ-
Feature. ot Feat p
. NpUt Features
6. For the Output Feature Class, click the L .
. |Harpere|la_Location 4 ﬂ 3
= ,
and navigate to your student folder. Output Feature Class
| C:\Student Folder\20ft_Harperella_Land_Buffer.shp ﬂ
7. Save the Output Features Class as Distance [value or field]
20ft_Harperella_Land_Buffer. (e Fincarund
| 20 |Feet |
8. Type 20 as the Linear unit. Verify that lr Field -
Feet is set in the pulldown menu.
oK ‘ Cancel | Environments... ‘ Show Help == ‘

9. Click to run the buffer process.

10. When the process is complete, a buffer complete window at the bottom of the screen will
appear briefly and then disappear. - .
= Harperella_Location

O
In the table of contents, the newest polygon 5 @ 20ft Harperella Land_Buffer
(20ft_Harperella_Land_Buffer) was added to the H o T
top of the polygons by default. You will need to

move the Harperella Location file up to be able to
view both at the same time.

11. Single click Harperella_Location in the
table of contents and drag it above the
20ft_Harperella_Land_Buffer.

(NOTE: You may have to click the List by

Drawing Order button :I in the above the
Table of Contents window if you are unable to B
reorder the layers.)

A second buffer will need to be created to designate r R
the “No Wake Zone” in the water. There will need to | £ 2uffer —
be buoys placed out 200 feet in the water from the e e e i
Harperella plants to keep boaters from creating [ Harperella_L ocation ~ ﬂ =
waves that might disturb the Harperella population. Output Feature Class
. . . | C:\Student Folder\200ft_Harperella_Water_Buffer.shp ﬂ
12. Double click again on the Buffer tool in bistance [value or field]
ArcToolbox. (@ Linear unit
| 200 |Feet =]
13. Select Harperella_Location as the Input (" Field
Feature. ! A
oK | Cancel ‘ Environments... ‘ Show Help == |
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14.

15.

16.

17.

18.

19.

For the Output Feature Class, navigate to your student folder.

Save the Output Features Class as 200ft_Harperella_Water_Buffer.

Set the Linear unit to 200 Feet.

Click to run the buffer process. During the process, a ribbon window will

open at the bottom of the screen.

When the process is complete, a buffer complete window at the bottom of the screen

will appear briefly and then disappear.

Click the Save button & to save your progress.

Using the Clip Tool

This buffer includes area both on land and in the

water. Our concern with this buffer is to focus in

tool to show only the area that is in the water.

O

o L

= Harperella_Location

on just the area in the water. You will use the Clip 2 B 20ft Harerella Land Buffer
m - _narp _ _

1.

In ArcToolbox, double click on Extract
under Analysis Tools to expand its list of

options.

Double click #* €'P to open up the Clip

dialog box.

Select 200ft_Harperella_Water_Buffer as

the Input Feature.

In the Clip Features box, select
Chatham_Water.

Save the Output Feature Class in
your student folder as
200ft_Harperella_Water_Clip.shp.

Leave XY Tolerance blank.

Click ‘i/ to process this
clip.

When the process is complete, a
clip complete window at the bottom

of the screen will appear briefly and
then disappear.

—

A Cip

==l

Input Features

\ 200ft_Harperella_Water_Buffer
Clip Features

|4

‘ Chatham_Water
Output Feature Class

‘ C:\Student Folder\200ft_Harperella_Water_Clip.shp
XY Tolerance (optional)

\ Feet

oK Cancel Environments...

<< Hide Help

[1
1 |w & |

Qutput Feature
Class

The feature class to be
created

Tool Help

44

TSA Demonstration Lessons adapted from: a Geospatial Industry Series in STEM, 1% Edition




9. Click =l to close the ArcToolbox pane.

You now have the area to be blocked off in the water as its P N\
own shapefile. This will allow you the edit the file to make v R
this area stand out on a map. |

10. Turn off the 200ft_Harperella_Water_Buffer f : "
shapefile in the table of contents.

11. Drag the 200ft_Haperella_Water_Clip file beneath
20ft_Haperella_Land_Buffer in the table of
contents.

12. Edit the symbology of the
200ft Haperella_Water_Clip to

10% Simple

hatch | bright red fill color, and the
same bright red color for the border
color.

13. Edit the symbology of the
20ft_Haperella_Land_Buffer to

Grassland

, bright red fill color, and the
same bright red color for the border
color.

Creating Shapefiles using ArcCatalog

On land, signs need to be placed near the outer edges of the buffer to keep hikers from
exploring the area in which the Harperella grows. In the water, markers, or buoys, need to be
placed to slow boaters down. In order to do this, you will need to create two different shapefiles
to show where these signs and markers should be placed.

1. On the Tools toolbar, click the ArcCatalog 31 button to open ArcCatalog.
The ArcCatalog window will open on the right side of the map display.

2. In the catalog tree, navigate to your student folder.
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10.

IO} Untstied - ArcMap -

A View Boolmarks Inesrt Selection Geoprocessing  Customize Windows  Help
L BEEED =y - - &by

i T = e ) gt

v v B I AR

SRR Sl S -
Right click on your LALLM L
student folder, select | %"
New and then T

¥ Eagle_Sightings

Shapefile.
B Chatham_Roads
= ﬁ_(lml.-.e'l- Water

B Woodlands Lodge Propery

B Chatham_County

The Create New
Shapefile window will
appear.

Name the file Protected_Area.

Leave the Feature Type as Point.

19816239 704346692 Feet

Because there is no Spatial Reference, click ﬁ to open the Spatial

Reference Properties box.

Import...

Click to Browse for Dataset.

Navigate to your student folder and single
click on a file you already established,
660_Eagle_Nest_Buffer.shp to set it as the
coordinate system for this shapefile.

Add

Click | to accept this

coordinate system.

Click | twice to close the
Spatial Reference Properties and Create
New Shapefile boxes and to create a new
shapefile.

Create New Shapefile | @ 23 |
MName: |Protected_Area
Feature Type: |Point ﬂ
Spatial Reference
Description:
Projected Coordinate System: -

MName: NAD_1983_StatePlane_North_Carolina_FIPS_3200_Fe

Geographic Coardinate System:
Mame: GCS_MNorth_American_1983

< | 1 »

Edit..

[ Coordinates will contain M values. Used to store route data.

[~ Show Details

[ Coordinates will contain Z values. Used to store 30 data.

oK Cancel
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Buoys will also need to be placed in the water to indicate to boaters a “no wake zone”.
This type of zone means that boaters must be going slow enough not to cause waves
that might be harmful to the tender vegetation of the Harperella plant.

11. Follow these same procedures to create a second shapefile naming it No_Wake_Zone.

12. The shapefiles are automatically added to your Table of Contents.
13.  Click the & to close ArcCatalog.
Using Heads Up Digitizing in Creating Shapefiles

The basic shapefiles you just created are projected, but contain no data. You will now add data
(points) to these shapefiles.

1. Open the Editor toolbar by going to Customize> Toolbars> Editor.
. Editor = ies
2. On the Editor toolbar, select - —_—_-_ and Start Editing.
3. From the source area of the list provided, select your student folder, Type :Shapefiles
OK
and then
4. The Create Features box will appear. Select | create Features =)
No_Wake_Zone. In Construction Tools at % - <Search v @
the bottom of the Create Features Window, Eagles Nest [ Construction Tools
Click on Point. l Eegles_test 5 point
No_Wake Zone ~ Point at end of line
@ No_Wake_Zone
You are going to place three buoys in the Protected_Area
water to designate the No Wake Zone. @ Protected Area B

5. Right click on the No_Wake_Zone file in the table of contents and Open Attribute
Table.

6. Move the Attribute table aside where you can see it, but it will not obstruct your view of
the water buffer zone.

7. Single left click to place three “buoys”
just on the edge of the buffer zone as
shown in the image to the right.

You will notice as you create these that L :
H] Attributes of No_Wake_Zone

the points will also be represented in your

table. FID Shape * Id
r 0 | Point 0
. R 1 |Point 0
8. To save these points, click 2 |Point 0

£>Save Edits, then
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.

22.

Editor =

>Stop Editing.
Close the Attributes of No_Wake_Zone table.
Double click the symbol for

No_Wake_Zone to open the Symbol
Selector box.

A

Triangle 3

Single click to select it.

Change the color to red and the size
to 15 point.

0K
Click to close the
Symbol Selector box.

You will now follow the same procedures to create places for warning signs for those on
land.

Right click on Protected_Area and select Open Attribute Table.

Move the Attribute table aside where you can see it, but it will not obstruct your view of
the buffer zone.

From the Editor toolbar, select Start Editing.

Select your student folder as the source file.

On the Create Features toolbar, verify that the Protected Shapefiles layer is selected.
In Construction Tools at the bottom of the Create Features Window, Click on Point

7

Place six points where signs will be posted around
the land side of the buffer.

Editor =

To save these points, click >Save Edits,

Editor =

then >Stop Editing.

Close the Attributes of Protected_Area table.
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23. Double click the symbol for Protected_Area to open the Symbol Selector box.

24.  Click Style References... and select Public Signs.
&
, Mo Entry
25. Scroll through the opens and find

OK
26. Edit the size to 15 and click to close the Symbol Selector box.

You are now able to view your boundaries established to protect these endangered plants.

Creating a Layout in ArcMap

Now that you have all of the data that you need to prove that neither XYZ Developers nor the
lodge owners are in violation of any rules or regulations regarding endangered or threatened
species, you can create a map to show that information.

Adding a Second Data Frame to the Layout

You will now create a layout that contains two maps; one showing the “big picture” and one that
is zoomed in to the lodge property. In order to accomplish this task, you will need a second
data frame.

1. Right click on & La¥ers and select Properties.
Data Frame Properties
2. Under the General tab, Name the data frame Lodge
Area. Annotation Groups ] Extent R
General I Data Frame l Coordir
. 0K
3. Click to close the Data Frame Name: ‘Lodge Area
Properties box. -
Description:
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4, Right click & Ledge Area 514 select Copy.
5. From the Main Menu, click Edit and select Paste.

All of the layers included in the original Lodge Area data frame are now copied into a
second data frame.

6. Right click on the second & Ledge Area  gejact Properties and name it Harperella
Zoom.

You are now ready to go to Layout view to set up your map.

7. Switch to Layout View by clicking on the Layout button [EXEZ} & 11 4 i the
bottom left corner of your map display window.

It has been decided that the layout would be best viewed from a Landscape view as opposed to
Portrait.

8. From the Main Menu, select File, Page and Print Setup.

9. Change the Orientation to Landscape.

10 Select the box to [+ Scale Map Elements proportionally to changes in Page Size

OK
11. Click to apply these changes.
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At this point, you do have two data frames displaying information for two identical maps. You
will need leave the extent of the Lodge Area map large and make Harperella Zoom a zoomed-in
inset of the Harperella plants near the lodge.

Differentiating Between Data Frames

When you have two or more data frames, one is always “active”. There are two ways to tell
which data frame is active: (1) the data frame title in the table of contents is bold, and (2) the
map that is active will have teal handles on it. Any changes made in the table of contents of the
active data frame will be shown in the active map that corresponds with it. To switch to another
data frame, simply click on the appropriate map in the layout or right click on its title in the table
of contents and select Activate.

1. If it is not already active, select the Harperella Zoom data frame.

m} 0 |
2. Use the Zoom In C: tool on the Tools toolbar

and zoom in as close to the Harperella site as
you can to include all buffered areas.

3. Resize this map by grabbing one of the corner
handles making it about one fifth of its current
size. (This map will be an inset when your
layout is complete.)

You will notice that the other map is below the
first map.

4, Activate the Lodge Area data frame and map
by clicking on the bottom most map. This map
will need to show a greater area. o 8 =

5. On the Tools toolbar, click the Fixed Zoom Out ** button until
the Scale (found on the Standard toolbar) is approximately
1:35,000.

k |‘I:35.DDD

| 4

6. Using the handles, stretch the map to cover almost two thirds of the page.

7. Because the Lodge Area map is a small
scale map, the Harperella plant area will
appear “cluttered”. To avoid this, turn off
both the Protected_Area and
No_Wake_Zone shapefiles in the Lodge
Area Data Frame in the table of contents.
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6.

7.

8.

8.

Drag the smaller map of the Harperella Zoom to a position on the right side of the map

towards the top. You will add information about this data frame under it in a few steps

Inserting a Title in a Map Layout
1.

Select

From the Main Menu, click Insert, and select
Title.

For the title, type Threatened and Endangered

Species Near Lodge Site

oK
Click

To enhance the title, double click it to open the
Properties box.

Change Symbol...

Click on Country 2, set the size to 20 and bold

oK
Click

Properties ‘ul

Texd |Size and Position

Text
Threatened and Endangered Species Near Lodge Site -
Font |Aria\2DD'D = =| =| =
Angle: (0.00 3: Characler Spacing.  [56.00 3:
Leading: 0.00

About Formatting Text ‘ Change Symbol |

0K | Cancel |

Apply

twice to close Symbol and Properties boxes
Position the title at the

top of the map layout
window.

Threatened and Endangered Species Near Lodge Site

ﬁ
AT

NS
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Inserting a Scale Line in a Map Layout
In order to add a scale bar, the proper data frame must be active.

1.

Inserting a Legend in a Map Layout
Because this map is zoomed in to show the detail around
the Harperella, you will only need the five layers.

1.

2.

Activate the Lodge Area data frame, by single clicking the date frame in the Map
Display.

From the Main Menu, click Insert,

then Scale Bar. Scale Bar Selector ‘ ‘ o
T —— e eee-—-—_ g \”ii’ Preview
Single click Scale Line 1 from the 7
options provided. LI e
0 50 100 200 Miles
————t———
Scale Line 2 L
rrrr 1171 T1] [
OK 0 50 100 200 Miles I
Click to close the Sealetmne3
Scale Bar Selector Window and B % a-
return to the map layout. Stepped Scale Line
9 s W 200 300 400 |— Scale fo ﬁt page
Drag the scale bar to a location bropertcs |
below the Lodge Area Data Frame. Aemaing Seale Bart
= = s Mare Styles - ‘
Activate the Harperella Zoom Atternating Scale Bar2 save. | _ Reset | |
data frame. 1 i oK Gancel |

Follow the same procedures to insert a Scale
Line in this small map.

Drag the scale bar to a location at the bottom of
the Harperella Zoom Data Frame. NOTE:
You may have to resize the scale bar horizontally
to make it fit under the Harperella Zoom Data
Frame.

With the Harperella Zoom data frame active, go =
to Insert then Legend. 0 75 150 300 Feet

In the Legend Wizard, first select ﬂ to clear
the current list of Legend Items listed on the right.
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3. Double click on the following layers to move them to the Legend Items box:
e Protected Area

No_Wake_Zone

20ft_Harperella_Land_Buffer

200ft_Harperella_Water_Clip

Harperella_Location

Choose which layers you want to include in your legend

Map Layers: Legend tems
- Eagles_MNest » 5 MNo_Wake Zone
-- Eagle_Sightings Protected_Areas @
. Chatham_Roads 20ft_Harperella_Land_Buffer

m

- Hamperella_Location
- 20ft_Harperella_Land_Buff
- 200ft_Hamperella_Water_C

- BEDft_Eagle_Nest Buffer

- Wonodlands_Lodge_Proper =

P il P 4 [ m = P
. Mext = .
4. Click to take you to the Legend Title page.

M i iD
.~ 200t_Harperella_Water_B e

5. Delete the default title of Legend from the box and leave it blank.
okl e o g
6. Click to take you to the Legend Gre‘e’j” Onv:e
Frame page' Yellow Sand
Sepia
7. Change the background to Grey 10%. Grey 40%
Hallow Il Black
[ JLlinearGradient [ | Rectangular Gradient
MNext = [ ] Circular Gradient |l Cretean Blue
8. CIick\—‘ to take you to the Symbol White <custom>

Patch page.

Next
9. Leave this page as is and click # to go to the Spacing Page.

. . , Finish ‘
10. Leave this page as is and click .

11. Position the legend below the Harperella Zoom map.
12. Activate the Lodge Area data frame.
13. Select Insert>Legend from the Main Menu.

14. Leave all layers to be included under Legend Items.
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15.

16.

17.

18.

19.

20.

21.

22.

23.

Mext
After clicking \E—bl, delete the title “Legend” from the next page of the Legend
Wizard.

Mext
Click i and change the background to Grey 10%.

. Mext = Finish
Click once more, then

Position the Legend in the bottom right corner of the Lodge Area map.
To split it into two columns, double click on the legend.
Single click on Harperella Location on the Legend Items side to select it.

Click in the box next to Place in new column to select it.

OK
Click to apply the change.

Move the scale bar to be placed just above the legend.

Threatened and Endangered Species Near Lodge Site

= FProiected Area
A& Mo Wsls Fons

- 20%_Harperella_Land_Bufer
B3 Esgles Mest [ |Harpersliz_Locaton F777] 2008_Harperells Water_Bufier

[{] Esgl_Sightings 20#t_Harperella_Land Bufer [
—— Chatham_Roads [-77] 200%_Harperella_Wster_Clip
[] ee0t_Eagle_Mest Bufier
|:| Weodlands Lodge Property
[] Ghatham_water
|:| Chatham_County

e
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Adding a Directional Arrow
Each map layout created needs a directional arrow included so that the reader always knows
which direction is north.

1.

2.

3.

4.

From the Main Menu, select Insert, then North Arrow.

From the list provided, select ESRI North 3.

OK
Click to add it to your map display.

Drag it below the Harperella Zoom legend.

Adding Text to a Map Layout
A few more pieces of information are needed to complete this layout. These will include
informational text boxes to display the author and date, as well as information about the two

maps.
1.

2.

9.

10.

From Main Menu, select Insert, then Text.
Enter your name, and then strike the Enter key.
Drag this text box to the bottom right corner of the map display window.

Double click on the text box to open the

ar [ D] <UR_MpRen_Latiu_ oum

Properties box. P 200#_Harperella_Waker_Bufier
|:| Harperells_Locston
Add the date below your name. Q )r:
] OK |
Click to accept the changes to the
text box.

Insert a second text box.
Enter the following text into the text box, returning at the ends of each of these lines:

Inset Above: A group of Harperella plants
were discovered near the lodge property.
"No Wake Zone" buoys were set up in the
water supplying a 200 foot buffer and signs
warning of a "Protected Area" were placed
on the land around these endangered plants
supplying a 20 foot buffer.

Double click on the text box to open the Properties box.

Ch Symbaol...
Click St and edit the font size to 11.
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0K
11. Click to return to the Text Properties box

OK
12. Click the Left Align button and click 4 to return to the map layout.
13. Drag this text box just below the Harperella Zoom map layout.

Adding Features from the Draw toolbar to the Map Layout

1. From the Draw toolbar, click the pull down arrow next to the A- and select Callout
; 0
2. Click the Eagles Nest to add a callout to be attached to the Eagle’s Nest point in the
Lodge Area map layout.
3. Enter the following text into the callout, returning at the ends of each of these lines:

Near the Lodge property, an eagle’s nest was found.
The lodge is well beyond the 660 feet buffer required
by the Bald and Golden Eagle Protection Act.

4. Double click on the text box to open the Properties box.

5. Click the Center Align =] button.

Change Symboaol...

6. Click | and edit the font size to 11.

7. To change the background of the callout to grey, click on | Editsymbol... | 514 then
select the Advanced Text| tap,

8. Click ﬂl under the Text Background section.

9. Click M and then Grey from the selection provided.

OK
10. Click | five times to close all editing boxes and return to the map layout.

11. Drag this callout to the top left corner of the Lodge Area map layout.
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Your layout should currently look like this; you may need to drag and reposition the elements in
the bottom right corner until they appear similar to the layout below:

Threatened and Endangered Species Near Lodge Site

T ud
Near the Lodge property, an eagle’s nest was found.
The lodge is well beyond fhe 88D feet bufer required
bythe Bakd and Gokien Eagle Protection Act

m
o 50 100 200 Feel
| S S N S -
e @ property:
A ol
. h
5 93 =
F3 Esgles Nest [ |Harperslls Locaton A MNo_Wske_Zons
| 20%_Harpersliz_Land_Bufsr
m
.

[0 Eagle Sightings [F5] 20t Harperella Land Bufer

——— Chatham_Roads [[777) 200%_Harperslls_Waer_Clip | [Z77] 200%_Harperella_Water_Bufier
[ ] 6208 _Eagle_Nest Bufer [ Harperetla_Locaton

[ Woodlands Lodge_Froperty

[ Chatham_witer A I

|:| Chatham_GCounty

L2010

A gray box will be added to the bottom right corner of the map layout to provide consistent
background to the text, legend, and compass elements.

M TS sealgmee=
12. From the Draw toolbar, select the New Rectangle O A
button. o T o "
13. Draw a rectangle as shown: @
NOTE: Do not be alarmed if the rectangle covers the » | a
existing elements, we will reorder the elements in the next u:.::p Z
steps. Buser
_Property
[} 0 a
14. Double click on the rectangle to open its properties box.

Q 51 100 200 Feel
S T S T S |

10%.

15. Click the Symbol tab and Edit the Fill Color to Gray ‘L

J Inset Above: A group.ol Harperells plants
were discoversd near the lodge property
“Mo Wake Zone” buoys were setup in the
water supphying a 200 ot bufier and signs
warning of 3 "Proected Area” were placed

an the land sround these endangered plants
@ supphying 3 20 foot buffer.
L A @ Proicted Ares
[m] A Mo Wsle Fone a
| Bufier 20#_Harperella_Land_Bufer
;r_gip : [777] 200t_Harperella_Water_Bufer
\Ear [ Herperelia_Locaton

roperty

17.  Right click on the text box and select Order, then Send A 2enm0
to Back. =) o a

OK
16. Click to apply the new color.
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18.

19.

20.

21.

22.

23.

24.

25.

One last item to add is an arrow to allow the reader to know where the Harperella
Location is located on the small scale map.

Click the down arrow beside the New Rectangle tool to display your drawing options.
O o

Select the New Line tool.

To draw a line, single click near the Harperella Location in small scale/large extent
map. The line will follow your movements; double click on the Harperella Zoom (large
scale) inset map to finish the line.

he 820 faot bular required
agle Protection Act

.4

=5

a 1
a 50 100

[

Inset Above: A group of H
were discovered near the
"Mo Wake Zone” buoys W
watar sunnhing 2 200 e

Double click on the line to open the Properties box.

Change Symbaol...

Click to open the Symbol Selector.

—

Scroll down the list to find | A™" 3 End|

Change the width to 2.00.

OK
Click twice to accept and close the Symbol Selector and Line
Properties windows.

Saving and Exporting Map Layouts
Once you map is complete, you will need to save it and then export a copy of it as a picture so
that it may be able to be used in other applications or just simply to be printed.

wn

Click to save the map.

Double click on the text box to open the Properties box.
Export Map.

Navigate to your student folder and save the map as STEM_Lesson03_XX.

Verify that the Save as type is JPEG (*.jpg).
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6.

7.

8.

Save

Click

Double click on the text box to open the Properties box, then Print. Print one copy.

Close ArcMap.

60

TSA Demonstration Lessons adapted from: a Geospatial Industry Series in STEM, 1% Edition



OL0cirie
4E1S 100

N

uonedo ejjaladiey _H_

12ung I=1eM " eljiadieH ¥z [
soyng” pueT elpiadiey Yoz BT
aU07 JEM ON W
ealy papald @

“Jayng oo} Oz & Bufiddns

sjue|d pasafiuepus 253y] punole pue| 3y3 uo
paoe|d alam ,Baly paalold, e o Buiuiem
sufiis pue 1ayng 100} gog € Buitiddns 1a1em
ay) ul dn 195 a1em shong ,3U07 SNENA ON.
“Auadoid afipol ay) Jeau palanodsip alam
sjued ejlaladiey jo dnolf y anoqy 1asU|

1224 002 0oL 05 0

funon weyeyD _H_
e weyeyd ||
fpadoig abpo spuejpooip _H_
sjeyng seN 20e3 w099 [ |
din 1 elledadie T U00zZ ﬁ mvmow_l_,:m yreyy ——
layng pue e|pladiey Yoz [Z- sbunybis sbeg E

g
uoneso ejRsadiey _H_ 1seN salfes Y
. I
[ 1 T T
284 0009 0052 052>, 0
*
=
T
1] t
/l\ll’//
!

PV uoiaalold sjbe3 uapjog pue pleg s Aq
painbal 1ayng 199} 094 au} puokaq |jam st abpol syl
‘puno}sem 1sau sa|6ea ue ‘fuadoid abipoq sy Jeapy

By P ! =

911 abpo- 1eaN so109dg palabuepuszg pue pauajeaiyl

61

Copyright © 2013 Digital Quest, Inc.



62

TSA Demonstration Lessons adapted from: a Geospatial Industry Series in STEM, 1% Edition



	2_Trademarks page_SM_b1
	Printed in the United States of America.

	3_STEM SM_TOC_b1
	4_Front Matter SM_b2
	STEM_Lesson01_r1_wwlr
	Lesson 1:  Can We Preserve Green Space in our Community?
	a Geospatial Industry Series in STEM
	Using GIS to Support Sustainable/Green Technology
	You will now use an existing ArcMap document to add, and then analyze different layers of data for the New Paltz Mill Brook Preserve.  ArcMap is launched in the same manner as most Windows-based application programs.

	STEM_Lesson02_r1_wwlr
	Lesson 2:  Where Can A Biodiesel Fuel Company “Strike” Oil?
	a Geospatial Industry Series in STEM
	Using GIS to Support Sustainable/Green Technology

	STEM_Lesson03_r1_wwlr
	Lesson 3:  How can Geospatial Technology be Beneficial to Conservation Biology?
	Those involved in Conservation Biology want to perform actions that will keep plants and animals from becoming extinct.  Without their efforts, many of the plants and animals that you see today would not be in existence.  The following scenario will t...
	with a keen sense for conservation biology.
	a Geospatial Industry Series in STEM
	Using GIS to Support Sustainable/Green Technology
	Launching ArcMap:
	ArcMap is launched in the same manner as most Windows-based application programs.
	A completely blank map document will open.




